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¿Qué es Mathematica?
Wolfram Mathematica (wolfram language) inicialmente surgió orientado al cálculo 

simbólico, pero desde hace años es un entorno integral de programación que puede 

utilizarse practicamente en cualquier campo y área de conocimiento ( lingüística, 

demografía, finanzas, química o lo que Ud pueda imaginar. ).  Permite utilizar lenguaje 

natural, accede en tiempo real a datos depurados de infinidad de campos, puede ejecu‐

tarse en la nube, dispone de funciones optimizadas orientadas al Machine Learning, 

Big data y mucho más. 
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¿Qué vamos a hacer?
‐ Algunas novedades de Mathematica aplicada a las Matemáticas

‐ Cómo elaborar documentos y presentaciones en Mathematica

‐ El formato libre y otras formas para empezar a utilizar Mathematica rápida‐

mente. Wolfram Alpha

‐ Datos computable: Obteniendo y tratando datos de distintos campos (Ciencias 

de la vida, meteorologia, economía, física y química, astronomía, etc).

‐ Ideas básicas de programación

‐ Calculo simbólico, numérico, gráficos.

‐ Imagenes.

‐ Creando aplicaciones interactivas. Geometric Region

‐ Probabilidad y Estadística

‐ Machine Learning 

‐ Paralelizacion

‐ Aplicaciones para la nube

‐ WOLFRAM ENTERPRISE PRIVATE CLOUD

Aplicaciones avanzadas Wolfram Language en la Investigación y Enseñanza 3

Wolfram Research



Algunas novedades de Mathematica aplicada a las 

matematicas

Evaluación de derivadas a partir de la definición 
In[8]:= g[x_] := x2 ⅇx
In[9]:= dq1[x_] = DifferenceQuotient[g[x], {x, h}]

Out[9]=

ⅇx ⅇh h2 + ⅇh x2 + 2 ⅇh h x - x2
h

In[10]:= Limit[dq1[x], h → 0]
Out[10]= ⅇx x (x + 2)
Ecuaciones diferenciales parciales 

(https://www.wolfram.com/language/11/partial‐differential‐

equations/?product=mathematica)

Generación de oscilaciones en una membrana circular

In[11]:= eqn = r ∂2u(r, t)∂ t2  ∂∂r r ∂u(r, t)∂r ;

In[12]:= bc = u(1, t)  0;

In[13]:= ic = u(r, 0)  0, u(0,1)(r, 0)  1;(dsol = DSolve[{eqn, bc, ic}, u[r, t], {r, t}])
Out[14]//TraditionalForm= u(r, t) → 

K[1]=1

∞ 2 J0(r j0,K[1]) J1( j0,K[1]) sin(t j0,K[1])J0( j0,K[1])2 + J1( j0,K[1])2 ( j0,K[1])2 
Asymptotics. Nonlinear Differential Equations

Compute a polynomial approximation for a nonlinear first‐order ODE:
In[1]:= eqn = 3 y′[x]2 + 4 x y′[x] - y[x] + x2 ⩵ 0, y[0] ⩵ 1;
In[2]:= sol = Quiet[AsymptoticDSolveValue[eqn, y[x], {x, 0, 37}]]

Out[2]= - x2

4
- x

3
+ 1

Verify that this is an exact solution of the ODE:
In[3]:= Simplify[eqn /. {y → Function[{x}, Evaluate[sol]]}]

Out[3]= {True, True}
Metaalgoritmos

https://www.wolfram.com/algorithmbase/

FormulaData 
FormulaLookup["kinetic energy"]{KineticEnergy, KineticEnergyRelativistic}
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FormulaData["KineticEnergy"]
K⩵ 1

2
m v2

In[29]:= Column[{FormulaData[{"PlanckRadiationLaw", "Wavelength"}],
FormulaData[{"PlanckRadiationLaw", "Frequency"}]}]

Out[29]=

L(Λ)  2 h c2

Λ5 exp 1 h c/k
T Λ -1

L(Ν)  Ν3 (2 h/c2)
exp Ν 1 h/k

T
-1

MathematicalFunctionData
In[30]:= MathematicalFunctionData

incomplete elliptic integral E(z|m) MATHEMATICAL FUNCTION , "ArgumentSimplifications"
guide/TheoremProving FindEquationalProof

Prove an elementary theorem in propositional logic:

In[1]:= proof = FindEquationalProof[a⩵ c, {a⩵ b, b⩵ c}]
Out[1]= ProofObject Logic: EquationalLogic Steps: 5

Theorem: a⩵ c


Show the abstract proof network:

In[2]:= proof["ProofGraph"]

Out[2]=

Show the complete list of proof steps as a Dataset  object:
In[3]:= proof["ProofDataset"]

Out[3]=

Statement Proof

Axiom 1 b ⩵ a

Axiom 2 b ⩵ c

Hypothesis 1 a ⩵ c

SubstitutionLemma 1 a ⩵ c Input {A
Position 1

Construct {A
Orientation 1

6 total ›

Conclusion 1 True Input {H
Position 1

Construct {S
Orientation 1

6 total ›

Prove a theorem involving universal quantification in first-order logic:
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In[1]:= proof = FindEquationalProof[ForAll[x, f[g[x]] ⩵ g[f[x]]], ForAll[x, f[x] ⩵ g[x]]]
Out[1]= ProofObject Logic: EquationalLogic Steps: 4

Theorem: ∀x fg[x] ⩵ g[f[x]] 
Typeset a natural language argument:

In[2]:= proof["ProofNotebook"]

Out[2]=

Axiom 1
We are given that:

f[x]⩵g[x]
Hypothesis 1
We would like to show that:

f[g[x]]⩵g[f[x]]
Substitution Lemma 1
It can be shown that:

f[g[x]]⩵f[f[x]]
PROOF

We start by taking Hypothesis 1, and apply the substitution:

g[x_]→f[x]
which follows from Axiom 1.

Conclusion 1
We obtain the conclusion:

True

PROOF

Take Substitution Lemma 1, and apply the substitution:

g[x_]→f[x]
which follows from Axiom 1.

Build a function that performs the steps of the proof:
In[3]:= pf = proof["ProofFunction"]

Out[3]= Function[{},
Block[{EquationalProof`Axiom, EquationalProof`Hypothesis, EquationalProof`CriticalPairLemma,

EquationalProof`SubstitutionLemma, EquationalProof`Conclusion}, Axiom1 = f[x] ⩵ g[x];
Hypothesis1 = f[g[x]] ⩵ g[f[x]];
SubstitutionLemma1 = MapAt[Replace[g[x_] → f[x]], Hypothesis1, 2];
Conclusion1 = MapAt[Replace[g[x_] → f[x]],

SubstitutionLemma1, FirstPosition[SubstitutionLemma1, g[x_]]];
Conclusion1]]

In[4]:= pf[]
Out[4]= True

Algunas cosas que quizas nunca imaginó que Mathematica podía 

hacer:

  https://www.wolfram.com/language/11/multilingual‐functionality/?product=mathe‐
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matica
In[23]:= string = "Привет, как дела?";

In[24]:= origin = LanguageIdentify[string]
Out[24]= Russian

In[26]:= Transliterate[string, origin -> "Spanish"]
Out[26]= Privet, kak dela?
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 Edición de documentos. Estilos
Cada notebook de Mathematica es un documento completo e interactivo que combina 

texto, tablas, gráficos, cálculos y otros elementos, que permite editar documentos con 

una excelente calidad, listos para ser publicados (algunas revistas admiten directa‐

mente los documentos en formato de Mathematica). 

Desde la paleta Witting Assistant o desde la barra de menu:Format ▶ Text Color 
podemos seleccionar la fuente, aspecto, tamaño, color, etc. Podemos usar caracteres espe‐

ciales como .
Cuando vaya a escribir un nuevo notebook elija el estilo desde el principio con For‐

mat ▶ Stylesheet ▶ Stylesheet Chooser... o utilizando la paleta Witting Assistant. 

Pulse en la miniatura con plantilla con el estilo elegido (New), podrá utilizar esta 

plantilla para irla modificando adaptando el contenido a sus necesidades. 

Si va a preparar un documento para una presentación puede elegir entre distintos 

estilos Format ▶ Stylesheet ▶ SlideShow.

8 Mathematica: Aplicaciones avanzadas Mathematica 

http://diarium/usal.es/guillermo



El formato libre y otras formas para empezar a 

utilizar Mathematica rapidamente

Recuerde: Para ejecutar una celda Input seleccione la celda (poniendo el cursor del 

ratón en la marca de celda) y pulse [⇑]+ ↵ o [Entrar] en el teclado numérico o 

en el menú contextual seleccione "Evaluate Cell".  Para acceder directamente a Wol‐

framAlpha escriba en una celda tipo input un doble  igual, esto es ==

El formato libre

Escriba lo que quiere (formato lingüistico) (EN UNA CELDA TIPO INPUT use doble == 

o Shift+Enter). Tome la salida como plantilla y adaptela a sus necesidades.  Puede pro‐

bar con otras expresiones equivalentes (graph of the sine of x, visualize the sine of x, ..) y 

obtendrá el mismo resultado.

plot sinx where x=0 to 2pi

Plot[Sin[x], {x, 0, 2 * Pi}]

1 2 3 4 5 6

-1.0

-0.5

0.5

1.0

Pulse sobre la salida y obtendra el imput de Mathematica con la sintaxis adecuda.

integral of 1/(1 + x^3)
Integrate[1 /(1 + x ^ 3), x]

ArcTan -1+2 x
3


3

+ 1

3
Log[1 + x] - 1

6
Log1 - x + x2

Puede usarlo mas allá de las matemáticas.

melting point of caffeine

ChemicalData["Caffeine", "MeltingPoint"]

235.25 °C
Con Insert‐>  Inline  Free‐form podemos usar el formato linguistico en expresiones.  

Por ejemplo escribe: “40 random numbers” dentro de una funcion standard de Mathe‐

matica como ListPlot
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ListPlot 40 random numbers 

10 20 30 40

0.2

0.4

0.6

0.8

Entradas con el asistente de entrada contextual

Tal  cual escribimos una entrada se van mostrando las funciones más frecuentes que 

empiezan por las mismas letras. Para una misma función se nos muestra varias plantil‐

las relacionadas (Crt+May+K). 

Auto completion Function Templates Dynamic Highlighting

Un código de colores permite detectar errores de sintásis (segun vaya escribiendo vera 

como le va desplegando la ayuda)
Plot3D[Sin[], { x , xmin , xmax , { y , ymin , ymax }, Opti]

Interface predictiva (IP)

Al ejecutar una sentencia la interface predictiva muestra tras el ouput una barra de 

sugencias

 http://reference.wolfram.com/mathematica/guide/WolframPredictiveInterface.html 

Escribiendo = al inicio de una celda podemos utilizar formato lingüistico  que pode‐

mos combinar con la interface predictiva (IP)

Plot Sinx

Plots (1 of 2)
Plot[Sin[x], {x, -6.6, 6.6}]



-6 -4 -2 2 4 6

-1.0

-0.5

0.5

1.0
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Utilizar ejemplos incluidos (ExampleData)

Descargamos el “Origen de las especies” de Darwin (se incluye como ejemplo pero 

puede obtener desde varios sitios de Internet).
txt = ExampleData[{"Text", "OriginOfSpecies"}];

Nos preguntamos cuantas veces aparece la palabra “evolution”  y la comparamos con 

las veces que aparece “selection” 
StringCount[txt, "evolution"]
4

StringCount[txt, "selection"]
351

El uso de peletas (Palettes) es de gran ayuda, especialmente cuando 

queremos que las entradas se parezcan a la notación habitualmente 

utilizada en matematicas

Como ejemplo, en una celda input escriba (ayúdese de una paleta para trascribir el 

contenido) en la forma estándar lo siguiente y ejecútela.

∂x,ySinx y 
Cosx y 

2 y
- 1

2
x Sinx y 

El cálculo anterior también podemos mostrarlo en  notación clásica de las matemáti‐

cas. En Mathematica se denomina TraditionalForm.

Copie la celda input de arriba en una nueva celda y en la barra de menú eleja Cell ▶Convert To ▶ TraditionalForm 0 añada // TraditionalForm  para indicar que el resul‐
tado también se nos muestre en notación tradicional. Observe que la marca de celda 

aparece con un corchete serpenteado. El mismo menú podrá utilizarlo para conversión 

a otras formas.

∂2 sinx y 
∂ x ∂ y

cosx y 
2 y

- 1

2
x sinx y 

La forma tradicional anterior ocupa muchos recursos de ordenador. Además puede que 

le dé problemas de conversión si el fichero es leído en una versión anterior de Mathe‐

matica. Es recomendable usar la forma StandardForm o InputForm y reservar la tradi‐

cional para aquellos casos en los que se requiera editar el documento en alta calidad. 
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 Wolgram Alpha
In[27]:= Integrate x e^x

Indefinite integrals: Hide steps

 x ⅇx ⅆ x  ⅇx (x- 1) + constant

Possible intermediate steps:
Take the integral:

 ⅇx x ⅆ x

For the integrand ⅇx x, integrate by parts,  f ⅆ g  f g- g ⅆ f , where

f  x, ⅆ g  ⅇx ⅆ x,ⅆ f  ⅆ x, g  ⅇx:
 ⅇx x- ⅇx ⅆ x
The integral of ⅇx is ⅇx: ⅇx x-ⅇx + constant

Which is equal to:

Answer: ⅇx (x- 1) + constant

Plots of the integral:

min max

min max

Expanded form of the integral: Step-by-step solutionⅇx x-ⅇx + constant

S i i f th i t l t 0
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Series expansion of the integral at x=0:
-1+ x2

2
+ x3

3
+ x4

8
+Ox5

(Taylor series)
Big-O notation »

Definite integral:

-∞0 ⅇx x ⅆ x  -1
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Datos computables: Obteniendo y tratando datos 

de distintos campos (Ciencias de la vida, 

meteorologia, economía, física y química, 

astronomía, etc). 
In[28]:= ?*Data
Información en tiempo real

Existen funciones que acceden a datos en tiempo real, por ejemplo (es la temparature 

del lugar (ciudad) que estamos: 
AirTemperatureData[]
20. °C

Podemos elegir un lugar concreto y analizar datos historicos

In[4]:= DateListPlot
WeatherData Santander CITY , "WindSpeed", {{2018, 1, 1}, {2019, 01, 31}, "Day"}

Out[4]=

Jan Apr Jul Oct Jan

0

10

20

30

40
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Ideas básicas de programación: Reglas 

fundamentales

1. Funciones: Mayúsculas en los nombres de funciones: Cos, Sin.   

Mathematica dispone de miles de funciones, todas empiezan por una letra mayúscula. 

Si no conocemos el nombre exacto de una función pero sabemos las letras por las que 

empieza tecleelas en una celda tipo Input y el asistente de ayuda contextual desplegará 

las instrucciones de Mathematica que empiezan por esas letras, pulse sobre la función 

elegida y se le mostrará una plantilla. También puede utilizar la entrada en formato 

linguistico o la barra de herramientas.

2.  [  ] : Argumentos, lo que se desea calcular 
D[E^Cos[2 Pi x], x]-2 ⅇCos[2 Π x] Π Sin[2 Π x]

La misma función escrita utilizando la paleta (utilizando el formato estandar de Mathe‐

matica) :∂xⅇCos[2 Π x]
-2 ⅇCos[2 Π x] Π Sin[2 Π x]

Para escribir Π , ⅇ se utilizan símbolos especiales (ⅇ no es lo mismo que e, e es una letra 

sin otro significado) para lo que emplearemos la paletas o  podemos escribir Pi por Π y 
E^ o Exp[] por ⅇ
3.  {  } - listas o rangos

list = 3, Pi2, 4 Pi;
Si una función es listable podra introducir dentro de ellas una lista y la función se apli‐

cará a cada uno de los elementos de la lista
Attributes[Sin]{Listable, NumericFunction, Protected}
Sin[list]{Sin[3], 1, 0}

4.  Opciones 
Las funciones incluyen tienen opciones (si no se indican el programa usa las que tiene 

por defecto). Una forma de ver directamente las opciones de una función es 

Options[func] 
Options[Plot]
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Plot[ Sin[2 x + 1], {x, - 2 Pi, 2 Pi}, Filling→ Bottom]
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Funciones (o instrucciones)
Mathematica dispone de miles de funciones que a su vez pueden ser combinadas para 

construir funciones más complejas

Mathematica permite definir funciones de forma muy parecida al uso habitual en matemáti-
cas. La sintaxis habitual en el caso de una función de una variable es: f[x_]:= 
expr(x).  El blank ("_") junto a la variable sirve para especificar lo que sería la vari‐
able independiente de la función.  

f[x_] := 0.2 Cos0.3 x2
Ahora podemos asignar un valor a la variable independiente y obtendremos el valor de 

la función.
f[3]-0.180814

Aqui la utilizamos para representarla
Plot[f[x], {x, 0, 10}]

2 4 6 8 10

-0.2

-0.1

0.1

0.2

El mismo concepto puede generalizarse a varias variables. En este ejemplo utilizamos 

la función  f (x) antes definida.
g[x_, y_] := f[x] 2.3 Exp- 0.3 y2

Ahora podemos presentar el resultado en un gráfico 3D para lo que podemos utilizar 

Plot3D. Utilizamos la opción PlotRange->All para mostrar los puntos del rango para el 

que se cálcula la función, elimine la opción para comprobar lo que sucede. 
Plot3D[g[x, y], {x, -2 Π, 2 Π}, {y, -2 Π, 2 Π}, PlotRange -> All]

❦ Función

f (x_, y_) = logy - x2 ;
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❦ Dominio

FunctionDomain[f[x, y], {x, y}]
y > 0 ∧ logy - x2 ≥ 0 ∧ x2 - y < 0
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Cálculos, ...

Solve que da las soluciones mas habituales. 

sol1 = Solve[{a x + b y == 3, 2 x + 3 y == 7}, {x, y}]
x → - -9 + 7 b

3 a - 2 b, y → - 6 - 7 a
3 a - 2 b

sol1[[1, 1]]
x → - -9 + 7 b

3 a - 2 b
Si pretendemos obtener todas las soluciones posibles utilizarmos  Reduce . 

A veces no es posible encontrar una solución general y entonces es necesario establecer 

el dominio para la solución buscada, en el ejemplo se establce como dominio los 

números reales .

Reduce 272 x-1x == 92 x-1 , x , Reals
x⩵ 1

2
|| x⩵ 3

Soluciones geométricas
Solve[{x, y} ∈ InfiniteLine[{{0, 0}, {2, 1}}] && {x, y} ∈ Circle[], {x, y}]
x→ - 2

5
, y→ - 1

5
, x→ 2

5
, y→ 1

5


Aplicaciones avanzadas Wolfram Language en la Investigación y Enseñanza 19

Wolfram Research



Cálculo numérico 
La potencia en cálculo númerico es enorme, como ejemplo veamos alguna ecuación 

diferencial resuelta numericamente.
s = NDSolve[{y'[x] == y[x] Cos[x + y[x]], y[0] == 1}, y, {x, 0, 30}]
y → InterpolatingFunction Domain: {{0., 30.}}

Output: scalar 
Plot[Evaluate[y[x] /. s], {x, 0, 30}, PlotRange→ All]

5 10 15 20 25 30

0.2

0.4

0.6

0.8

1.0

ParametricPlot[Evaluate[{y[x], y'[x]} /. s], {x, 0, 20}]

0.2 0.4 0.6 0.8 1.0

-0.4

-0.2

0.2

0.4
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Aprovecha las posibilidades gráficas 

Muestre varios gráficos

Plot Sin[x]
x

, Sin[x], {x, -2 Π, 2 Π}

-6 -4 -2 2 4 6

-1.0

-0.5

0.5

1.0

Graphics3D[{{Opacity[0.2], Blue, Cylinder[]}, { Green, Sphere[]}}, Boxed→ False]

f (x_, y_) = x2 + y2;
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Utilice leyendas
Plot3Dx2 + y2, x + y, {x, -1, 1}, {y, -1, 1},
BoxRatios→ Automatic, PlotLegends -> "Expressions"

x2 + y2

x + y

Etiquetas

Coloque etiquetas donde quiera
Plot[{Callout[Log[x] Sin[x], "max", Above], Log[x] Cos[x]}, {x, 0, 2 Π}]

Graficos especificos
JuliaSetPlot[0.365 - 0.4 ⅈ, PlotLegends→ Automatic]

-1.0 -0.5 0.0 0.5 1.0

-1.0

-0.5

0.0

0.5

1.0

Puede utilizar Control D para elaborar un gráfico sofisticado
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Visualizacion: Interface predictiva  e imágenes
El tratamiento de imágenes también ha experimentado una clara mejora en las últimas 

versiones de Mathematica. Desde Mathematica 9 cuando pulse en una imagen verá que 

justo debajo de la misma se muestra un menu que le dará numerosas posibilidades de 

actuar sobre la imagen.
ExampleData[{"TestImage", "Lena"}]

Pulse en los diferentes iconos. Por ejemplo, para more... se le desplegará el siguiente 

menu:
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ImageRotate[%, Right]
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MODELIZACION CON Manipulate 

(http://demonstrations.wolfram.com)

Ejemplo básico

En este caso creamos un gráfico mas complejo en el que dejamos que el usuario pueda 

modificar los parámetros a y b
Manipulate[
Plot3D[Sin[x + a] Sin[y + b^2], {x, 0, 2 Pi},{y, 0, 2 Pi}, PlotRange→ 1, PlotPoints→ 20, Mesh→ True],{a, 0, 2 Pi}, {b, 0, 2 Pi}]
a

b
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Funcionalidades: Operando con “Geometric 

Regions”
Una de las últimas funcionalidades es el tratamiento geométrico. Aqui obtenemos la 

región formada por la unión de dos circulos ℛ = RegionUnion[Disk[{0, 0}, 2], Disk[{1, 0}, 2]];
DiscretizeRegion[ℛ]

ℛ1 = RegionDifference[ℛ, Disk[{1/2, 0}, 1]];
DiscretizeRegion[ℛ1]

En este ejemplo vamos a resolver una ecuación diferencial limitada a una refión especí‐

fica definida geometricametne .∇{x,y}2 u[x, y]
u(0,2)[x, y] + u(2,0)[x, y]
sol = NDSolveValue∇{x,y}2 u[x, y] ⩵ 0, DirichletCondition[u[x, y] ⩵ Sin[x y], True], u, {x, y} ∈ ℛ1;
Plot3D[sol[x, y], {x, y} ∈ ℛ1] // Quiet
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Probabilidad y Estadística
Ademas de las aplicaciones basicas comunes eh muchos programas estadisticos Mathe‐

matica incluye entre otras :■ Funciones de probabilidad (guide/ParametricStatisticalDistributions).‐ De acuerdo 

con la información proporcionada en la página del fabricante el número de funciones 

es sustancialmente superior a las que contienen otros conocidos programas de cál‐

culo estadístico como R, SAS, SPSS, etc.■ Distribuciones derivadas (guide/DerivedDistributions).‐ Permite construir funciones 

de probabilidad que son combinación de otras distribuciones.■ Distribuciones no paramétricas (guide/NonparametricStatisticalDistributions).‐ Per‐

mite obtener funciones de distribución no paramétricas a partir de datos empíricos.■ Cálculo automatizado de probabilidades (Probability) y esperanza matemática 

(Expectation).■ Se amplían las propiedades asociadas a las distribuciones: PDF (distribución de densi‐

dad), CDF (función de distribución), SurvivalFunction (función de supervivencia), 

Moment (momentos), EstimatedDistribution, ...■ Se aumentan las posibilidades de generación de números aleatorios (RandomVariate), 

de amplio uso en simulación Montecarlo y en numerosos análisis estadísticos, de 

acuerdo a la función de distribución que se especifique.■ Ajustes de datos para varias variables: regresión no lineal (NonlinearModelFit),  

modelo lineal generalizado (GeneralizedLinearModelFit) y modelo de regresión 

logístico (ProbitModelFit).■ Gráficos estadísticos específicos: DiscretePlot3D, Histogram, PairedHistogram, Quan‐

tilePlot, ProbabilityPlot, BoxWhiskerChart, DistributionChart, …■ Series temporales: guide/TimeSeriesProcesses. ■ Análisis de clusters mediante el comando FindClusters  y otros que se detallan en: 

guide/DistanceAndSimilarityMeasures. ■ Análisis de supervivencia y fiabilidad. ■ Procesos estocásticos (guide/RandomProcesses), incluida ecuaciones diferenciales 

estocásticas.

FindFormula

Generate data with normally distributed noise:
In[5]:= SeedRandom[4311]
In[6]:= data = Table[{x, -x + 2 Sin[x] + RandomVariate[NormalDistribution[0, 0.2]]},{x, RandomReal[{-10, 10}, 100]}];

Visualize the data:
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In[7]:= ListPlot[data]

Out[7]= -10 -5 5 10

-10

-5

5

10

In[14]:= fit = FindFormula[data, x, 1]
Out[14]= 2.0155 sin(x) - 0.996833 x

In[15]:= Show[ListPlot[data], Plot[fit, {x, -10, 10}, PlotRange→ All]]
Out[15]= -10 -5 5 10

-10

-5

5

10

FindDistribution

Generate data sampled from an exponential distribution:
In[16]:=  = ExponentialDistribution[1];

data = RandomVariate[, 1000];
Find the best distribution from the data:

In[18]:= estimated = FindDistribution[data]
Out[18]= ExponentialDistribution[1.02784]
Compare the PDFs for the original and estimated distributions:

In[19]:= Plot[{PDF[, x], PDF[estimated, x]}, {x, 0, 10}, PlotLegends→ {"", "e"}]

Out[19]=

2 4 6 8 10

0.1

0.2

0.3

0.4


e
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Machine Learning

Simple
In[2]:= digit = Classify[{ → 2, → 5, → 8, → 0, → 2, → 7, → 5, → 1, → 3, → 0, → 3, → 9, → 6,→ 2, → 8, → 2, → 0, → 6, → 6, → 1, → 1, → 7, → 8, → 5, → 0,→ 4, → 7, → 6, → 0, → 2, → 5, → 3, → 1, → 5, → 6, → 7, → 5,→ 4, → 1, → 9, → 3, → 6, → 8, → 0, → 9, → 3, → 0, → 3, → 7, → 4,→ 4, → 3, → 8, → 0, → 4, → 1, → 3, → 7, → 6, → 4, → 7, → 2,→ 7, → 2, → 5, → 2, → 0, → 9, → 8, → 9, → 8, → 1, → 6, → 4, → 8,→ 5, → 8, → 0, → 6, → 7, → 4, → 5, → 8, → 4, → 3, → 1, → 5,→ 1, → 9, → 9, → 9, → 2, → 4, → 7, → 3, → 1, → 9, → 2, → 9, → 6}]

Out[2]= ClassifierFunction Input type: Image
Number of classes: 10


In[3]:= digit[{ , , , , , , , , , }]

Out[3]= {0, 1, 2, 3, 4, 1, 6, 7, 8, 9}
ImageIdentify

In[4]:= ImageIdentify 

Out[4]= English cocker spaniel
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Paralelizacion. 
Pretendemos factorizar los siguientes enteros  (46 digitos):

In[1]:= largeIntegers = {
3614639327625022357498716997616141559555385788,

1555448460931142740464025812509966226753668067,

2181897995524176530622591658224757998839632491,

1922853025887991704598930446931704051497624646,

2272856689805810352674075033225118441591285223,

2362930657136771575226664337831303048141997267,

2284188855407316248949247887514956603668459951,

1955774192657260628352808399207168800531153117};
Utilizando 1 kernel 

In[2]:= AbsoluteTiming[
Map[FactorInteger, largeIntegers]]

Utilizando los kernels disponibles combinado con Parallelize 
In[3]:= LaunchKernels[]

Out[3]= {KernelObject(1, local), KernelObject(2, local)}
In[4]:= AbsoluteTiming[

Parallelize[Map[FactorInteger, largeIntegers]]]

32 Mathematica: Aplicaciones avanzadas Mathematica 

http://diarium/usal.es/guillermo



Cloud aplication
La función CloudDeploy  permite generar aplicaciones para que se ejecuten en la nube. 

Inserte el enlace en un sitio web desde el que podrá ejecutarse.
CloudDeploy[Manipulate[ContourPlot3D[x^2 + y^2 + a z^3⩵ 1,{x, -2, 2}, {y, -2, 2}, {z, -2, 2}, Mesh→ None], {a, -2, 2}]]
CloudObjecthttps://www.wolframcloud.com/objects/d13d97f6-33da-47b7-9b1f-52304ea9c62b

Aplicaciones avanzadas Wolfram Language en la Investigación y Enseñanza 33

Wolfram Research



webMathematica
http://www.wolfram.com/products/webmathematica/index.html

http://oed.usal.es/webMathematica/
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WOLFRAM ENTERPRISE PRIVATE CLOUD

https://www.wolfram.com/enterprise‐private‐cloud/
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Materiales adicionales: 
Lo que hay que saber: http://www.wolfram.com/language/elementary‐introduction/

https://www.crcpress.com/Mathematica‐Beyond‐Mathematics‐The‐Wolfram‐Lan‐

guage‐in‐the‐Real‐World/Len/9781498796293

http://www.wolfram.com/mathematica/quick‐revision‐history.html

http://www.wolfram.com/training/special‐event/?source=nav

Inicio
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